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adapted from the Help section of Microsoft Movie Maker 

System requirements 
Windows Movie Maker requires the following minimum system configuration:  

• Microsoft Windows XP Home Edition or Windows XP Professional  
• A 600 megahertz (MHz) processor, such as an Intel Pentium III, Advanced Micro 

Devices (AMD) Athlon, or equivalent processor  
• 128 megabytes (MB) of RAM  
• 2 gigabytes (GB) of free hard disk space  
• An audio capture device (to capture audio from external sources)  
• A DV or analog video capture device (to capture video from external sources)  
• An Internet connection (to save and send a movie to the Web or to send a movie 

as an attachment in an e-mail message)  

To optimize the performance of Windows Movie Maker, the following system 
requirements are recommended:  

• A 1.5 gigahertz (GHz) processor, such as an Intel Pentium 4, an AMD Athlon XP 
1500+, or equivalent processor  

• 256 megabytes (MB) of RAM  

The following software is required to play back a movie:  

• Microsoft Windows 98 or later or Windows NT® 4.0 or later  
• Software that can play Windows Media Video (WMV) files, such as Microsoft 

Windows Media Player 7.0 or later (Windows Media Player 9 Series is 
recommended to optimize movie playback)  

Supported file types 
You can import files with the following file name extensions into Windows Movie 
Maker to use in your project:  

• Audio files: .aif, .aifc, .aiff .asf, .au, .mp2, .mp3, .mpa, .snd, .wav, and 
.wma  

• Picture files: .bmp, .dib, .emf, .gif, .jfif, .jpe, .jpeg, .jpg, .png, .tif, .tiff, and 
.wmf  

• Video files: .asf, .avi, .m1v, .mp2, .mp2v, .mpe, .mpeg, .mpg, .mpv2, .wm, 
and .wmv  
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Getting started 
You can use Windows Movie Maker to capture audio and video to your computer from a video 
camera, Web camera, or other video source, and then use the captured content in your movies. 
You can also import existing audio, video, or still pictures into Windows Movie Maker to use in the 
movies you create. After editing the audio and video content in Windows Movie Maker, which can 
include adding titles, video transitions, or effects, you can then save your final movie and share it 
with friends and family. 

You can save the movies you create to your computer or to a recordable (CD-R) or rewriteable 
(CD-RW) CD (depending on your CD recorder). You may also choose to share it with others by 
sending the movie as an attachment in an e-mail message or by sending it to the Web. If you 
have a digital video (DV) camera connected to your computer, you can also choose to record the 
movie to a tape in your DV camera and then play it back on the DV camera or on a TV. 

Understanding collections, projects, and 
movies 
Collection 

A collection contains audio clips, video clips, or pictures that you have imported or captured in 
Windows Movie Maker. A collection acts as a container for your clips, which are smaller 
segments of audio and video, and helps you organize the imported or captured content. 
Collections appear in the Collections pane of Windows Movie Maker. 

Project 

A project contains the arrangement and timing information of audio and video clips, video 
transitions, video effects, and titles you have added to the storyboard/timeline. A saved project file 
in Windows Movie Maker has an .mswmm file name extension. By saving your projects, you can 
open the project file later and begin editing it in Windows Movie Maker from where you last 
saved. 

Movie 

A movie is the final project you save by using the Save Movie Wizard. You can save a movie to 
your computer or to a recordable CD, send it as an attachment in an e-mail message, or save 
and send it to the Web. 

The saved movie can be watched in a media player, such as Microsoft Windows Media® Player, 
or in a Web browser. If you have a DV camera connected to your computer, you can also record 
your movie to a tape. You and others can then watch the movie on the DV camera or on a TV. 
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Understanding source files 
Source files are the digital media files (for example, audio and video files) or 
pictures that you import into your current project.  

When you import a video, audio, or picture file, the file remains in the original 
location from which it was imported. The resulting clip that appears in Windows 
Movie Maker is a representation of the original source file; it is not a copy of the 
source file. In other words, if you edit the source file in another program after it is 
already imported into Windows Movie Maker, the changes that you make to the 
file automatically appear in Windows Movie Maker and in any Windows Movie 
Maker projects that include the edited clip. And, if you delete the thumbnail or clip 
for the file in Windows Movie Maker, the source file still remains unchanged in 
the original location. To ensure that you can continue to work with a project, 
avoid renaming, deleting, or moving the original source files. 

About video capture devices 
A video capture device lets you transfer live or recorded video to your computer. 
In Windows Movie Maker, you can use the following types of capture devices to 
capture video (and in some cases, audio as well) to your computer:  

• Analog video source such as an analog camera or video cassette recorder 
(VCR) connected to an analog capture card  

• Web camera  
• Digital video source such as a DV camera or VCR connected to an 

Institute of Electrical and Electronics Engineering (IEEE) 1394 port (DV 
capture card or built-in port)  

• TV tuner card  

About audio capture devices 
An audio capture device lets you capture audio from an external source to your 
computer. The most popular type of audio capture device is a microphone. The 
microphone can be a stand-alone microphone attached to your computer, or it 
can be a microphone that is part of your DV or analog camera or Web camera. 
You can use the following types of audio capture devices:  

• Audio card (also referred to as a sound card)  
• Stand-alone microphone  
• Built-in microphone in an analog camera or Web camera  
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Connecting capture devices 
The following list details the capture devices you can use and how they can be 
connected to your computer. For complete information about connecting your 
specific capture device to your computer, see the documentation associated with 
your hardware.  

• Web camera connected to either a USB port, video capture card, or 
IEEE 1394 port. Depending on the type of Web camera, you can connect 
it to a USB port (if it’s a USB camera), to an analog capture card (if it’s a 
video composite camera), or to an IEEE 1394 port (if it’s an IEEEE 1394-
compatible Web camera). Some Web cameras have a built-in microphone 
so you can use the Web camera for capturing both video and audio for 
your projects.  

• Analog camera or VCR connected to an analog capture card. In this 
configuration, you connect a camera or VCR to an analog capture card. 
For example, you could connect the video line out on the camera to the 
video line in on the capture card. You could then to connect the left and 
right audio lines (often through RCA-style left- and right- channel 
connectors to a single 3.5mm stereo plug adapter) to the line in on your 
audio card (or analog video capture card if your card has both audio and 
video). If both your camera and capture card provide S-video connections, 
you could also choose to use the S-video connection to record the video 
while leaving the audio connectors attached so the audio is captured. 
Again, the specific configuration depends on your hardware.  

• DV camera or VCR connected to an IEEE 1394 port. When a DV 
camera is connected to an IEEE 1394 port, you get the best quality 
available from your DV device. Because the data is already in a digital 
format, it is simply passed through the IEEE 1394 port to your computer. 
In this configuration, the IEEE 1394 cable is connected from the DV out 
port of your DV camera or VCR to the DV IEEE 1394 card or built-in IEEE 
1394 port.  

• DV camera or VCR connected to an analog video capture card. Many 
DV devices have analog outputs. If you have an analog video capture 
card, you can connect the DV camera or VCR to the analog capture card 
to transfer video and audio to your computer.  

• Microphone connected to a sound card or USB port. To capture audio 
from a microphone, you connect it to the microphone or line-in input on 
your computer. Some microphones attach to a USB port on your 
computer.  

• TV tuner card. To capture video from TV if you have a TV tuner card 
connected and installed on your computer.  
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Capturing video 
You can capture video and audio to your computer by using Windows Movie Maker. To begin 
capturing, a video capture device must be connected properly and detected on your computer by 
Windows Movie Maker. Some audio and video capture devices and sources that you can use 
include a digital video (DV) or analog camera or VCR, a Web camera, a TV tuner card, or a 
microphone. You can capture content live or from video tape. 

When capturing video and audio in Windows Movie Maker, the Video Capture Wizard proceeds 
as follows:  

1. Select the capture devices you want to use. For more information about choosing capture 
devices, see Choosing a video and audio capture device.  

2. Specify where you want your captured audio and video file to be saved. For more 
information about choosing a destination for your captured audio and video file, see 
Choosing a saving destination.  

3. Choose the video setting. For more information about choosing a video setting for 
capturing video and audio, see Choosing a video setting.  

4. If you are capturing audio and video from a video tape in a DV camera or DV VCR, 
choose the method you want to use to capture video and audio. For more information, 
see Choosing how to capture from a DV device.  

5. Capture the video and audio. For more information, see Capturing video and audio.  

• If you have a DV camera connected to an IEEE 1394 port, the camera must be turned on 
for it to be detected by Windows Movie Maker.  

Choosing a video and audio capture device 
Available devices 

Lists the available capture devices you can use for capturing video. If you only have one video 
capture device attached to your computer, that device is the only one listed. 

For many video capture devices, the name of the device is listed according to the hardware 
manufacturer’s name and device name. For example, when capturing video from an analog 
camera attached to an analog capture card on your computer, you would choose the analog 
capture card as the capture device for this option. 

Video input source 

Lists the available input connection lines based on the number of lines available for the selected 
video capture device For example, if an analog capture device has multiple input connections, 
such as an S-video connection and a composite video connection, you need to choose which 
input connection line to use for capturing video. If only one input line can be used for capturing by 
the device, that line is selected and this option does not appear.  This option is not available for a 
DV camera connected to an IEEE 1394 port.  



 

Janet Benincosa 
jhbeninc@access.k12.wv.us 

Page 6 of 32 

Configure 

Click to change the configuration of the selected video capture device. The resulting dialog box 
depends on the specific capture device you are using. For more information about the options 
available in the resulting Configure Video Capture Device dialog box, see Understanding the 
Configure Video Capture Device dialog box.  This option is not available for a DV camera 
connected to an IEEE 1394 port. 

Audio device 

Lists the available audio capture devices you can use for capturing audio. If you have only one 
audio capture device, such as your default sound card, that device is selected automatically.  This 
option is available only for analog devices. 

Audio input source 

Lists the available connection input lines based on the number of input connections available for 
the selected audio device. For example, if you have a microphone attached to the microphone 
line input of your computer, you would choose Microphone as the audio input source.   This 
option is available only for analog devices with multiple line inputs. 

Input level 

Adjusts the volume of the captured audio. 

When choosing the capturing level, select an input level toward the upper part of the meter 
without entering the red-colored area, which is marked by the second line from the top. If the 
capturing level is set too low, the captured audio may be too low to be heard. Conversely, if the 
capturing level is set too high, the captured audio may be too loud and distorted.  

For some devices, such as a DV camera connected to an IEEE 1394 port, the capturing volume 
cannot be adjusted by dragging the audio level slider. 

• This page of the Video Capture Wizard does not appear when a single DV device 
connected to an IEEE 1394 port is the only video capture device found on the computer.  

Choosing a saving destination 
Enter a file name for your captured video 

Provides a space for you to enter a file name for the captured video file. After completing the 
wizard, you can add this file to the storyboard/timeline and then edit it. 

The file name cannot be longer than 64 characters and cannot include the following characters: \ / 
: * ? " < > | 
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Choosing a video setting 
This page of the Video Capture Wizard lets you choose what settings you want to 
use when capturing video and audio. The video setting you choose determines 
the quality and file size of the captured video file. Video display size and video bit 
rate increase with higher video settings, and so does the file size. Consider file 
size along with the main purpose for your captured video when choosing the 
video setting.  

Best quality for playback on my computer (recommended) 

Specifies that you want to capture video at the recommended video setting. This 
video setting encodes the captured video at a higher quality setting. The specific 
capture profile that is detected and used by Windows Movie Maker for this video 
setting depends on the selected capture device and the audio and video it can 
output to the computer, as well as the processor speed of your computer. 

This setting is well-suited for a majority of the video you capture in Windows 
Movie Maker and plan to edit in Windows Movie Maker, and then plan to save to 
your computer, to a recordable CD, as an attachment to an e-mail message, or to 
the Web using the Save Movie Wizard. 

Show more choices 

Click to see additional video settings. Therefore, if you do not choose to use the 
Best quality for playback on my computer (recommended) video setting, you 
can choose from a listing of other capture options. 

Digital device format (DV-AVI) 

Specifies that your captured video will be saved as DV-AVI file with an .avi file 
name extension. This capture option is only available if you are capturing from a 
DV device, such as a DV camera or DV VCR. This video setting is designed to 
be used if you want to edit the captured video on your computer and then later 
save it back to a tape in a DV camera or VCR using the Save Movie Wizard. The 
quality of the original video is retained when you choose this setting, so the 
movies you record retain their original video quality when recorded back to DV 
tape. 

However, video files saved with this setting can be quite large. For example, 
each minute of video saved at this setting can consume as much as 178 MB of 
disk space. Therefore, verify that there is enough available disk space on your 
hard disk to accommodate the amount of video you want to capture. 
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Other settings 

Provides a list of additional video settings you can choose to capture for your 
captured video. When choosing a setting from this list, consider how you plan to 
ultimately use and share the video in your final saved movies. This list ranges 
from settings suited for video on a Pocket PC to video for local playback.  

Setting details 

Displays additional information about the video captured at the current setting. 
The following details are provided: 

File type. The type of file the captured video is saved as on your computer. 
Possible file types include Windows Media Video (WMV) or Audio-Video 
Interleaved (AVI). 

Bit rate. The total bit rate of the captured video and audio. Typically, a higher bit 
rate will result in higher-quality video with smoother motion. However, as the bit 
rate increases, so does the size of the captured video file. 

Display size. The dimensions of the captured video picture, in pixels. The first 
number indicates the width of the video, while the second number indicates the 
height of the video. 

Frames per second. The number of frames that are displayed per second in the 
captured video. Typically, a higher number or frames per second will make the 
motion of objects or persons in your video appear smoother. 

Video format. The video standard for the saved movie file. The two possible 
formats are NTSC and PAL. The specific video format depends on the selected 
video capture device and the video format it uses. This value is displayed when 
capturing video as a DV-AVI video file. 

Video file size 

Provides the estimated file size of the saved movie and disk space available to 
store the captured video file. The estimated amount of disk space consumed by 
one minute of video is displayed in this area for many video settings. For other 
video settings that are based on the quality of the captured video and audio, such 
as the recommended setting, a file size estimate is not available. 
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Choosing how to capture from a DV device 
This page of the Video Capture Wizard lets you choose how you want to capture 
video from tape in your DV camera or other DV device. 

The following options appear on this page. 

Capture the entire tape automatically 

Specifies that you want to automatically capture the entire video tape. When you 
select this capture method, the tape in the DV device is automatically rewound to 
the beginning and capturing begins automatically. 

Select this option if you want to capture the entire video tape to your computer. 

Capture parts of the tape manually 

Specifies that you want to manually select which scenes to capture from the 
video tape. Select this option if you plan to start and stop capturing multiple times 
to capture different parts of the video tape. 

• This page is only displayed if a DV camera is selected as the capture 
device, and the camera is in VCR mode (to play back video tape).  
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Capturing video and audio 
This page of the Video Capture Wizard displays when you are capturing content live or 
from tape and lets you choose options for the content you are capturing.  

You can choose to start and stop capturing individual parts of video manually. For 
example, you might want to capture only certain parts of a video tape. In this situation, 
you can capture a part of the tape, stop capturing, locate the next part you want to 
capture, and then begin capturing again. This reduces the amount of unnecessary video 
that is captured to your computer. Regardless of the number of times you start and stop 
capturing video, the captured video is saved as one video file in the location specified on 
the Captured Video File page of the wizard. 

The following options and information appear on this page. 

Start Capture - Click to begin capturing audio and video to your computer.  

Stop Capture - Click to end capturing audio and video to your computer.  

Video captured - Displays the amount of time elapsed for the current capture in 
the form of hours:minutes:seconds (h:mm:ss) by default. Timing starts when 
capturing begins and stops when capturing ends. 

Size of video file - Displays the file size, in kilobytes (KB), as the video is being 
captured. If you have time or space restrictions for your captured content and 
your final movie, you can use the timing information in Video captured. 

Estimated disk space available - Displays the estimated amount of disk space 
that is available (in gigabytes (GB) or megabytes (MB)) for capturing video with 
audio at the currently selected video setting. 

Create clips when wizard finishes - Specifies whether the captured video is 
divided into clips when it is saved and imported into Windows Movie Maker. 
Creating clips separates captured video into manageable sizes. How clips are 
created is determined by the video capture device your video is captured from. 
For example, if you are capturing from a DV device, a clips are created based on 
time stamp information set by the DV camera when the video is originally 
recorded. However, if you are capturing from an analog device, such an analog 
camera or Web camera, a clip is created when there is a substantial change in 
one frame of the video compared to the next frame. 

If you don’t choose to create clips, the video appears as one large clip when you finish 
capturing. 
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Mute speakers - Specifies that you want to mute the speakers and all audio 
output lines that are connected to the audio card on your computer. Muting the 
speakers prevents audio from being played back on the speakers, which can 
distract from the video and audio you are capturing. 

If you clear this check box, audio such as any background music or other sounds from 
your computer that are played back over your speakers may be heard and captured if 
you are capturing live content. 

Capture time limit - Specifies whether there is a capturing time limit. If this box 
is selected, capturing stops automatically when the specified time limit elapses. If 
this check box is cleared, you must stop capturing manually. You should then 
monitor the capturing so you can stop capturing at the time you want if you don’t 
select a maximum capture time. Time is displayed in the form of 
hours:minutes(h:mm).  

For each video segment you capture for which the time limit expires, the time displayed 
for Video captured is reset. 

Digital video cameras controls (DV only) - Provides buttons to control your DV 
camera from your computer. You can click the DV controls to play, pause, stop, 
rewind, fast-forward, or to move forward or backward by individual frames. You 
can use these controls when your DV camera or DV VCR is connected to an 
IEEE 1394 port, and the DV camera or VCR is in the playback position to capture 
taped video and audio to your computer. 

• When capturing video from a DV camera, verify that the camera is in either VCR 
or Camera mode. Capturing video or pictures while the camera is in a mode to 
take still pictures is not supported.  

• When recording in Windows Movie Maker, the limit on the size of an individual 
captured file depends on the amount of hard disk space you have available and 
the file system format you are using. The file size limits for the different file 
system formats are shown in the following table.  

File system format File size limit  

NTFS Unlimited 

FAT32 4 gigabytes (GB) 

FAT16 2 GB 
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To capture the entire video from a tape in a DV camera 

1. Make sure your DV device is connected properly to an IEEE 1394 port, 
and then set the camera mode to play recorded video (often labeled VTR 
or VCR on a DV camera).  

2. On the File menu, click Capture Video.  

–or- 

In the Movie Tasks pane, under Capture Video, click Capture from 
video device. 

3. On the Video Capture Device page, in Available devices, click the DV 
camera.  

4. In the Enter a file name for your captured video box, enter a file name 
for your captured video file. Then, in the Choose a place to save your 
captured video box, select the location where you want your video to be 
saved or click Browse to select a location.  

5. On the Video Setting page, choose the video setting you want to use for 
capturing video and audio.  

6. On the Capture Method page, click Capture the entire tape 
automatically.  

The tape in the DV camera rewinds. Capturing begins automatically and 
ends when the video tape ends. 

7. Select any of the following commands:  
• To separate the video into smaller clips, select the Create clips 

when wizard finishes check box.  
• To stop capturing before the end of the video tape, click Stop 

Capture, and then click Yes in the resulting dialog box to save the 
video that has been captured.  

8. To close the Video Capture Wizard, click Finish.  

The captured content is imported into a new collection with the same 
name as the specified video file. 

 
 
 
 



 

Janet Benincosa 
jhbeninc@access.k12.wv.us 

Page 13 of 32 

 
 

To capture parts of video from a tape in a DV 
camera 

1. Make sure your DV device is connected properly to an IEEE 1394 port, and then set the 
camera mode to play recorded video (often labeled VTR or VCR on a DV camera).  

2. On the File menu, click Capture Video   or    

In the Movie Tasks pane, under Capture Video, click Capture from video device. 

3. On the Video Capture Device page, in Available devices, click the DV camera.  
4. In the Enter a file name for your captured video box, enter a file name for your 

captured video file. Then, in the Choose a place to save your captured video box, 
select the location where you want your video to be saved or click Browse to select a 
location.  

5. On the Video Setting page, select the video setting you want to use for capturing video 
and audio.  

6. On the Capture Method page, click Capture parts of the tape manually.  
7. To separate the video into smaller clips, select the Create clips when wizard finishes 

check box.  
8. To prevent audio from playing over your speakers while capturing video, select the Mute 

speakers check box.  
9. To automatically stop capturing after a time period has elapsed, select the Capture time 

limit check box, and then type or select the length of time you want to capture. Time is 
displayed in the form of hours:minutes(h:mm).  

10. Locate the video and audio you want to capture from your tape by using either the 
controls on your DV camera or VCR or the DV camera controls in the wizard.  

11. To begin capturing video, click Start Capture.  

The tape plays automatically and capturing begins. 

12. Do one of the following:  
• When the tape reaches the point at which you want to stop capturing, click Stop 

Capture.  
• If you have selected the Capture time limit check box, wait for the specified 

amount of time for video to be captured.  
13. Repeat steps 10 through 12 for each part of the video tape you want to capture.  
14. When you have finished capturing, click Finish to close the Video Capture Wizard.  

The captured content is imported into a new collection with the same name as the 
specified video file. 



 

Janet Benincosa 
jhbeninc@access.k12.wv.us 

Page 14 of 32 

To capture video from tape in an analog camera 
or VCR 

1. Make sure your analog camera or VCR is connected properly to your computer, and then 
set the camera mode to play recorded video (often labeled VTR or VCR on an analog 
camera).  

2. On the File menu, click Capture Video   or    

In the Movie Tasks pane, under Capture Video, click Capture from video device. 

3. On the Video Capture Device page, do the following:  
• In Available devices, click the analog device you want to use to capture video, 

and then, in the Video input source list, click the input line you want to use.  
• If you want to adjust and configure the video capture device settings, click 

Configure.  
• In the Audio device list, click the audio capture device you want to use, and 

then, in Audio input source, click the input line you want to use.  
• To adjust the volume of your captured audio, move the Input level slider to the 

level you want to use.  
4. In the Enter a file name for your captured video box, enter a file name for your 

captured video file. Then, in the Choose a place to save your captured video box, 
select the location where you want your video to be saved or click Browse to select a 
location.  

5. On the Video Setting page, select the video setting you want to use for capturing video 
and audio.  

6. To separate the video into smaller clips, select the Create clips when wizard finishes 
check box.  

7. To prevent audio from playing over your speakers while capturing video, select the Mute 
speakers check box.  

8. To automatically stop capturing after a time period has elapsed, select the Capture time 
limit check box, and then type or select the length of time you want to capture. Time is 
displayed in the form of hours:minutes(h:mm).  

9. Using the controls on your analog camera or VCR, locate the video and audio you want 
to capture from your tape.  

10. To begin capturing, click Start Capture, and then press the Play button on your analog 
camera or VCR.  

11. Do one of the following:  
• When the tape reaches the point at which you want to stop capturing, click Stop 

Capture, and then press the Stop button on your analog camera or VCR.  
• If you have selected the Capture time limit check box, wait for the specified 

amount of time for video to be captured, and then press the Stop button on your 
analog camera or VCR.  

12. Repeat steps 9 through 11 for each part of the video tape you want to capture.  
13. When you have finished capturing, click Finish to close the Video Capture Wizard.  

The captured content is imported into a new collection with the same name as the 
specified video file. 
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To capture live video 
1. Make sure the capture device is connected properly. If you are using a DV or 

analog camera, set the mode on your camera to capture live video and audio 
(often labeled Camera).  

2. On the File menu, click Capture Video   or    

In the Movie Tasks pane, under Capture Video, click Capture from video 
device. 

3. On the Video Capture Device page, do the following:  
• In Available devices, click the analog device you want to use to capture 

video, and then, in the Video input source list, click the input line you 
want to use.  

• If you want to adjust and configure the video capture device settings, click 
Configure.  

• In the Audio device list, click the audio capture device you want to use, 
and then, in Audio input source, click the input line that you want to use.  

• To adjust the volume of your captured audio, move the Input level slider 
to the level you want to use.  

4. In the Enter a file name for your captured video box, enter a file name for your 
captured video file. Then, in the Choose a place to save your captured video 
box, select the location where you want your video to be saved or click Browse 
to select a location.  

5. On the Video Setting page, select the video setting you want to use for 
capturing video and audio.  

6. To separate the video into smaller clips after the wizard completes and the video 
is captured, select the Create clips when wizard finishes check box.  

7. To prevent audio from playing over your speakers while capturing video, select 
the Mute speakers check box.  

8. To automatically stop capturing after a time period has elapsed, select the 
Capture time limit check box, and then type or select the length of time you 
want to capture. Time is displayed in the form of hours:minutes(h:mm).  

9. To begin capturing, click Start Capture.  
10. Do one of the following:  

• To stop capturing, click Stop Capture.  
• If you have selected the Capture time limit check box, wait for the 

specified amount of time for video to be captured.  
11. Repeat steps 9 and 10 to capture another segment of live video.  
12. Click Finish to close the Video Capture Wizard.  

The captured content is imported into a new collection. 

• If you are using a DV camera that is connected to an IEEE 1394 port to capture 
live video, the audio and video input sources do not appear.  
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Importing existing digital media files 
You can import existing digital media files that are supported by Windows Movie Maker 
to use for your project. The files you can import might be stored on and imported from 
your hard disk on your computer, a shared network location, a CD, or on removable 
media. When importing files in Windows Movie Maker, you can import one file or multiple 
files at one time.  

A source file you import remains in the same location from which it was imported. 
Windows Movie Maker does not store an actual copy of the source file; instead, a clip 
that refers to the original source file is created and appears in the Contents pane. After 
you import files into your project, don’t move, rename, or delete the original source files. 
If you add a clip to a project after the corresponding source file has been moved or 
renamed, Windows Movie Maker attempts to automatically locate the original source file. 
If the source file is deleted, it must be placed on your computer, or on a location your 
computer can access, again. 

After you upgrade to this release of Windows Movie Maker, your collections file, which 
stores information about your collections and the clips contained within your collections 
in Windows Movie Maker, from a previous release of Windows Movie Maker is imported 
and upgraded automatically when you first start this version of Windows Movie Maker. 
You can then continue using your collections and content in this version of Windows 
Movie Maker. Therefore, if you have used previous versions of Windows Movie Maker, 
you can use the content you have already imported without needing to re-import the 
digital media files. You can import the collections file automatically at a later time if you 
cancelled importing and upgrading your collections file automatically when Windows 
Movie Maker was first started. 

• Digital media files that have been protected using digital rights management 
cannot be imported into Windows Movie Maker.  

Previewing projects and clips 
As you work on a project, you can preview the project periodically in the monitor 
to check your editing. Or, if you want to preview individual clips, you can use the 
Contents pane to ensure you captured the content you want to use in your 
movies. Use the playback buttons to move from frame to frame or from clip to 
clip. 

• When you preview your project in Windows Movie Maker with the monitor set to 
display at 640x480 pixels, the video will not appear optimally. However, the 
video in the final saved movie plays back and is displayed at a higher quality 
level.  
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Editing clips - You have several options for editing clips:  

• Splitting a clip. You can split a video clip into two clips. This is useful if you want 
to insert either a picture or a video transition in the middle of a clip. You can split 
a clip that appears on the storyboard/timeline of a current project, or you can split 
the clip in the Contents pane.  

• Combining clips. You can combine two or more contiguous video clips. 
Contiguous means the clips were captured together so that the end time of one 
clip is the same as the start time of the next clip. Combining clips is useful if you 
have several short clips and you want to view them as one clip on the 
storyboard/timeline. Similar to splitting a clip, you can combine contiguous clips 
in the Contents pane or on the storyboard/timeline.  

• Trimming a clip. You can hide parts of a clip you do not want in your project. For 
example, you can trim the beginning or end of a clip. Trimming does not remove 
the information from the source material; you can clear the trim points to return 
the clip to its original length at any time. Clips can only be trimmed after they 
have been added to the storyboard/timeline. You cannot trim clips in the 
Contents pane.  Drag the trim handles to trim the unwanted portions of the clip. 

• Creating clips. You also create clips from video clips after they have been 
imported or captured in Windows Movie Maker. This lets you create clips at any 
time when working in Windows Movie Maker. By separating video clips into 
smaller clips, you can easily find a particular part of your captured or imported 
video to use in your movie.  

Organizing collections and clips 
You can organize the source material you capture into collections and clips for use in future 
projects. A collection serves as a container for clips, which you can organize in many ways. For 
example, you might organize your collections by an event category.  You can change how your 
clips are displayed in the Contents pane to see varying amounts of detail about the individual 
clips within a collection. In the Thumbnails view, you can view the title and a bitmap image of 
each clip. In the Details view, you can view all the properties of each clip. 

In Windows Movie Maker, you can choose to arrange your clip according to different clip 
properties. This lets you choose how you want to display your clips in the Contents pane so you 
can quickly find the specific clip you are looking for. For example, if you were looking for a picture 
that began with an A, you could choose to arrange the clips by name so that file would appear at 
the top of the Contents pane. The properties you can choose to arrange clips by depend on the 
selected folder in the tree pane.  The following list identifies how the different file types can be 
arranged.  

• Video clips and pictures. Clips can be arranged by name, duration, start time, 
end time, dimensions, or source.  

• Audio. Clips can be arranged by name, duration, start time, end time, or source.  
• Video transitions and video effects. Clips can be arranged by name.  
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Saving a project 
Saving your project lets you keep your current work, and then later open the file in Windows 
Movie Maker to make further changes. You can continue editing your project from where you left 
off when you last saved the project. When you save a project, the arrangement of clips added to 
the storyboard/timeline, as well as any video transitions, video effects, titles, credits, and any 
other edits you made are retained. 
A Windows Movie Maker project file is saved with a .mswmm file name 
extension. 
You can also save an existing Windows Movie Maker project file with a new name. This enables 
you to use the saved project as the basis for other new projects. For example, if your current 
project contains a short introduction to a movie, you can save the existing project with a new 
name and then continue editing. When you wanted to create a new movie that includes the same 
short introduction, you can then open the original project file that contains only the introduction, 
and then make additional edits without needing to re-create the introduction of your movie. 

Saving and sending movies 
The Save Movie Wizard lets you quickly save your project as a final movie. The timing, layout, 
and contents of the project are saved as one complete movie. You can save and store the movie 
on your computer or on a recordable CD, or you can send it as an attachment in an e-mail 
message or to a video hosting provider on the Web. In addition to these choices, you can choose 
to record your movie to a tape in a DV camera.   

My computer - Specifies that you want to save your movie to your local computer or to a 
shared network location. 

Recordable CD - Specifies that you want to save your movie to a recordable or rewriteable 
CD (CD-R or CD-RW). Choose this option if you have a rewriteable or recordable CD drive 
attached to your computer and you want to save your final movie to a recordable or rewriteable 
CD.  

E-mail - Specifies that you want to save your movie as an attachment to send in an e-mail 
message. Choose the option to share smaller movies with others by sending them in e-mail by 
using your default e-mail program. 

The Web - Specifies that you want to save your movie and then send it to a video hosting 
provider on the Web. A video hosting provider is a third-party provider on the Web that provides a 
Web server location and hosts the movies you save in Windows Movie Maker. Choose this option 
if you want to save your movie so family and friends can watch your movie on the Web. 

DV camera - Specifies that you want to send your movie to a tape in your DV camera. This 
option is available when you have a DV camera connected to an IEEE 1394 port. Choose this 
option if you want to save your movie to a tape so you and others can watch it on the DV camera 
or on a TV (when you connect the camera to a TV). 
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There is a correct way to save your Movie Maker projects, and you should know how before you 
start editing for the first time … especially if you ever want to back up your video project, transfer 
it to another computer, or re-edit your project in the future.  

When you first save a project in Movie Maker 2, the program generates a “movie maker 
project file” on your computer’s hard-drive. You can name and save this project file anywhere 
you want, though Movie Maker will attempt to place it within your “My Movies folder.”  

But what exactly IS this project file?? 

The project file is a “linking file“ that keeps track of every item in your home movie. This 
includes every video clip, music song, picture, and voice track … the project file knows 
where each of these items are located on your computer, how they are laid out on the movie 
timeline, and what effects and transitions should be applied to each. 

However, these video objects are not actually “embedded” within the 
project file. If you examine the project file itself, you’ll see 
that it is only 1 meg in size … while your movie may 
contain several gigabytes worth of video files. That’s 
because the project file only “links” to the actual 
multimedia files. Because of this, you really need to 
organize all your files if you ever want to re-edit your project.  

Why is this?  

Suppose that sometime in the future you decide to give your computer a “spring cleaning” 
and reorganize some of your media files. You can damage a project if you inadvertently 
move or delete a file that is used in one of your videos. The next time you open up your 
video project, Movie Maker won’t find the media file “where it expected to 
find it” and your project will be forever ruined.  

To avoid this problem and keep your project intact, I recommend creating a 
new folder for each of your video projects. You should then save every 
movie element into this folder before you import them into Movie Maker. 
This folder should include your captured video, background music, pictures, voice narration, 
and the project file itself. With all your files together like this, there is no chance of a file being 
inadvertently deleted or moved. Plus, this method allows you to easily transfer your entire 
project to another computer (or backup onto an external hard drive) … all you have to do is 
copy and paste this single folder.  

Don’t underestimate the importance of organization when it comes to editing 
video. Unless you stay on top of things, your hard drive can quickly become 
cluttered with random video clips and pictures, and you won’t know what’s safe to 
delete. Organizing each of your movies into its own folder will save you a lot of 
trouble and heartache down the line.  You can find more useful home-video "tips 
and tricks" like this one at www.mightycoach.com - they even have an online-
video course that teaches you to edit video on your home computer! 
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Setting general options 
The General tab lets you set the default options for general settings and options 
in Windows Movie Maker. By using this dialog box, you can customize and 
configure some settings in Windows Movie Maker to fit your own needs. 

In this tab of the Options dialog box, the following options appear. 

Default author 

Specifies the default name of the person who created the movie. The name is 
displayed by default when you save a project as a movie; the author’s name 
appears when the movie is played in some media players, such as Windows 
Media Player. Therefore, do not enter any personal information that you do not 
want others to see. For more information about privacy, see the Windows Movie 
Maker privacy statement at the Microsoft Web site. 

Temporary storage 

Specifies the temporary storage location for captured audio, as well as saved 
movies. When you are capturing an audio narration, the temporary buffer file is 
stored in this location, and then removed when the final captured audio file is 
saved. 

When saving a movie that you are going to send in an e-mail message or to a 
video hosting provider on the Web, a copy of the movie file is stored in this 
location until the movie is sent successfully. When sending a movie to a tape in a 
DV camera, the temporary movie file that is created is stored in this location until 
the movie is recorded to the tape.  

Click Browse to find the location you want to specify as your temporary storage 
location on your computer. You may want to change your temporary storage 
location to specify a location that has more available disk space. For example, if 
your hard disk has two partitions, you may want to choose the drive that has 
more available disk space when capturing video or saving a movie that you want 
to record to a tape in a DV camera. 

Open last project on startup 

Specifies whether the last saved project is opened automatically when Windows 
Movie Maker is started. If this check box is cleared, a new blank project is started 
when Windows Movie Maker is started.  
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Save AutoRecover info every 

Specifies that you want a project and your collections file to be saved automatically after the 
specified amount of time, in minutes. When this check box is selected, the project and collections 
file is automatically saved, along with any changes in your project and collections during the 
specified amount of time. This lets you recover your work if a power failure or similar problem 
should occur. 

Download codecs automatically 

Specifies that Windows Movie Maker attempts to download codecs automatically when you 
choose to import a video or audio file that uses a codec that is not installed on your computer. 
You must be connected to the Internet for this option to work. If the appropriate codec is found on 
a Microsoft Web site, the codec is then downloaded and installed silently without any user 
intervention. 

If you do not want codecs to be installed automatically on your computer, clear this check box. To 
install codecs, you must have the appropriate Administrator permissions.  

Reset Warning Dialogs 

Click this button to reset the different warning dialog boxes that appear in Windows Movie Maker. 
If you selected the Do not show this dialog again in one of the different warning dialog boxes, 
these warning dialog boxes will appear again after you click this button. 

Clear All Passwords and User Names 

Click this button to reset all user names and passwords that have been entered and stored in 
Windows Movie Maker. In Windows Movie Maker, user names and passwords are stored on a 
per-user basis. You could click this button to clear the user name and password so that the 
appropriate user name and password must be re-entered when you send a movie to the Web if 
you selected the Save my password check box when saving a movie to a video hosting provider 
on the Web. This helps to add another layer of security, so that others cannot send a movie to a 
video hosting provider using your account information. 

Restore All Defaults 

Click this button to return Windows Movie Maker to the default settings for options and settings 
displayed on the General tab. For example, if you selected a new temporary storage location and 
changed the default author name, and later decided that you wanted to change these setting 
back to the default, along with other options displayed on the General tab, you can click this 
button to return to the default settings. 
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Setting advanced options 
The Advanced tab lets you set the default options for advanced settings and 
options in Windows Movie Maker. By using this dialog box, you can customize 
and configure some settings in Windows Movie Maker to fit your own needs. 

In this tab of the Options dialog box, the following options appear. 

Picture duration 

Specifies the default amount of time you want pictures to display in your project 
when added to the Video track of the timeline or to the storyboard. The default 
duration is determined by the current setting when the clip is added to the 
storyboard/timeline. For example, if you imported several pictures and then 
added them to the storyboard/timeline with the Picture duration option set to 
five seconds, the pictures added to the Video track would display for five 
seconds. However, if you changed the default duration to 10 seconds and then 
added pictures to the storyboard/timeline, the newly added pictures would display 
for 10 seconds. 

Transition duration 

Specifies the default amount of time you want video transitions to display in your 
project and final saved movie when added to the Transition track of the timeline 
or to a video transition cell on the storyboard. The default duration for video 
transitions is also determined by the current setting when the clip is added to the 
storyboard/timeline. For more information about working with video transitions, 
see Working with video transitions. 

Video format 

Specifies the video format that is used when recording a movie back to tape. The 
format you choose determines the video format used by your DV camera, which 
varies by country or region. The selected video format is used when the movie is 
sent to tape in your DV camera if Windows Movie Maker cannot automatically 
detect the video format for your DV camera. This setting is automatically set 
based on the Regional and Language Option settings in Control Panel. 

The current video format also determines whether either the NTSC or PAL 
settings are displayed when capturing video or saving movies after selecting the 
Other settings option for either task. For more information about the video 
format used by your DV camera, consult the documentation provided with your 
DV camera. 
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Aspect ratio 

Specifies the aspect ratio for your saved movies. The setting you choose 
determines the aspect ratio, which is the relation of the width to the height, of the 
video display for your final saved movie. 

If you select 16:9, the settings you can choose from when saving a movie include 
settings that have a width to height ratio of 16:9. If you select 4:3 as the aspect 
ratio, the settings you can choose from include profiles that have a width to 
height ratio of 4:3. Video converted between the two aspect ratios may cause the 
final saved movie to appear distorted during playback. 

Maximum file size for sending a movie as an attachment in an e-mail 
message 

Specifies the maximum file size for sending a movie as an attachment in an e-
mail message. You can set this option according to any attachment file size limits 
that may be set by your e-mail provider. Windows Movie Maker then 
automatically selects the best movie setting based on the duration and content 
on the storyboard/timeline and the file size limit you enter. 

Because many e-mail providers have attachment file size limits, you can set this 
value to the file size limit of your e-mail provider. Windows Movie Maker displays 
a warning if the movie you are saving exceeds the file size limit that is set when 
you choose the E-mail saving option in the Save Movie Wizard. 

Restore All Defaults 

Click this button to return Windows Movie Maker to the default settings for 
options and settings displayed on the Advanced tab. For example, if you 
selected a new default duration for pictures and video transitions, and later 
decided that you wanted to change these setting back to the defaults, along with 
other options displayed on the Advanced tab, you can click this button to return 
to the default settings for this tab. 
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Creating Video for the web 
Microsoft's Windows Movie Maker is free video editing suite that is part of Windows ME 
and XP installation. It is quite easy to use and has a range of features that should satisfy 
the beginner. 

 

(1) Movie Task Menu 
(switchable to/ from 
collections list via icons 
below (4)) 

(2) Collection view 
frame (if use pull down 
bar above can jump to 
video transitions or 
effects menues) 

(3) Video playback 
window 

(4) Menu options and 
icons 

(5) Edited video timeline   

However it has many limitations. It doesn't support quicktime 
or real video files. It can only export as either windows media 
video (.wmv) or DV quality .avi file (not practical for web 
video). Whilst creating small web clips is easy saving DV 
quality footage back to your video camera can take hours. 

You're going to need to have a video capture device (e.g. 
camcorder, digital camera or web cam- for more on these 
choices). 

With a video camera things are relatively straight forward in 
transfering your footage to your computer, provided you have a suitable 
connection. Most digital video cameras have a high speed DV out socket which 
will allow connection to a firewire (IEEE 1394) port on your computer.  Other 
video cameras (especially analogue ones) will require a you to connect to your 
computer through a video capture device. 
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If you open Windows Movie Maker and Click file -> capture video, (or select this 
option from the on screen menu (1)), you may be able to automatically capture 
your video file via Windows Movie Maker. If this isn't the case make sure you 
have installed the relevant drivers, software etc for your camera and/or capture 
device. If this doesn't work try using the software with the capture device to save 
the file (preferably in .avi format). 

If you use another capture device make sure it captures video in suitable format 
(.asf, .avi, .m1v, .mp2, .mp2v, .mpe, .mpeg, .mpg, .mpv2, .wm, and .wmv). It 
won't take quicktime movie files (.mov) for example. Simply select either file -> 
import into collections and locate your file or use import video (1) option from 
the on screen video. In all cases it is worth backing up your video files in case of 
accidents. 

If you have a long video file (e.g. video camera footage), windows movie maker 
may offer to cut the clip up for you automatically. If not you can right click over 
the video file in the collection window and select create clips. 

You can now simply drag and drop file clips down onto video line in (5) the 
editing pane. You can cut these files by either clicking clip -> split or using the 
split button in the view window (3). You can right click and select delete over 
unwanted sections (if you slip up select edit -> undo..). Right clicking over your 
sections also allows you to mute sound, fade in and out or add effects etc. You 
can also drag other clips dowwn onto your timeline. 

You can add video effects, transitions and titles by either clicking relevant option 
in menu box under 2.Edit Movie in (1) or click tools or use the pull down menu 
at (4). You either follow on screen instructions or you can drag and drop the 
option onto your video timeline (5). You can drag and drop your clicks around to 
resequence and you can also add stills and music files (just import them as 
above but with relevant options) 

Once you've made and checked your masterpiece, you can create suitable file to 
be placed on line. Either click file -> Save Movie File and select My computer 
(the web option well discuss later) or click save to my computer option in 3. 
Finish Movie in (1). You'll be prompted to give your file a name (remember all 
one case) & select a location to save it to (e.g. your website folder). You'll then 
be given a range of options. 
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Select Other Settings (A) and pull down to select a suitable file type These are 
based on estimate download or network speeds if the file was being streamed 
but will reduce your file size down. If you look at setting details you'll see the file 
type resolution and frames per second rate. Beside it you will see movie file info. 
Remember video files even with compression can be huge. You may need to 
select a slower speed file option or reduce your video's length. Most people with 
a modem (56Kbps or less) won't want to download files bigger than a few 100 Kb 
unless they have a really good reason. 

Once you're happy click Next >. 

Just create a link to your file as described elsewhere in this tutorial area and 
upload your video file and relevant webpages to your site. 
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Keyboard shortcuts 
Shortcut keys are available for many of the commands in Windows Movie Maker. 
By using shortcut keys, you can quickly accomplish common tasks.  

Task Shortcut key 

Create a new project CTRL+N 

Open an existing project CTRL+O 

Save a project CTRL+S 

Save a project with a new name F12 

Save a movie CTRL+P 

Capture video CTRL+R 

Import an existing digital media file CTRL+I 

Undo the last action CTRL+Z 

Redo the last undone action CTRL+Y 

Cut  CTRL+X 

Copy CTRL+C 

Paste CTRL+V 

Delete DELETE 

Select all clips CTRL+A 

Rename a collection or clip F2 

Clear the storyboard/timeline CTRL+DELETE 

Show or hide the storyboard/timeline CTRL+T 

Zoom in on the timeline PAGE DOWN 

Zoom out on the timeline PAGE UP 

Add selected clips to the storyboard/timeline CTRL+D 

Play video in full screen ALT+ENTER 

Set start trim point CTRL+SHIFT+I 
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Set end trim point CTRL+SHIFT+O 

Clear trim points CTRL+SHIFT+DELETE 

Split a clip CTRL+L 

Combine contiguous clips CTRL+M 

Nudges clip to the left CTRL+SHIFT+B 

Nudges clip to the right CTRL+SHIFT+N 

Play or pause clip SPACEBAR 

Stop playback on the storyboard/timeline CTRL+K 

Play content on the storyboard/timeline CTRL+W 

Rewind content on the storyboard/timeline CTRL+Q 

Back CTRL+ALT+LEFT ARROW 

Forward CTRL+ALT+RIGHT ARROW 

Previous frame ALT+LEFT ARROW 

Next frame ALT+RIGHT ARROW 

Display Help topics F1 

Select previous item (on a timeline track, on the 
storyboard, or in the Contents pane) 

LEFT ARROW 

Select next item (on a timeline track, on the 
storyboard, or in the Contents pane) 

RIGHT ARROW 

Select item above (on a timeline track or in the 
Contents pane) 

UP ARROW 

Select item below (on a timeline track or in the 
Contents pane) 

DOWN ARROW 

Go to the first item (on a timeline track, on the 
storyboard, or in the Contents pane) 

HOME 

Go to the last item (on a timeline track, on the 
storyboard, or in the Contents pane) 

END 
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Creating a DVD from Your Windows Movie Maker Movies 
in Microsoft Windows XP Media Center Edition 2005 

http://www.microsoft.com/windowsxp/using/mce/videopics/MMdvd.mspx 
 
You can capture and edit video in Windows Movie Maker, and then save your movie to share with others. However, if you 
are using Windows Movie Maker in Microsoft Windows XP Media Center Edition 2005, you can take this one step further 
and copy your saved movie to a DVD. 

To begin the process of copying a movie to a DVD from within Windows Movie Maker, 
your computer must be running Microsoft Windows XP Media Center Edition 2005, a recordable 
DVD drive must be installed on your computer, and the appropriate MPEG-2 video encoding 
software must be installed on your computer. 

To save a movie to a recordable DVD 

1. Insert a blank recordable DVD. It can be any of the following types of recordable DVDs, depending 
on your specific recordable DVD drive: DVD+R, DVD-R, DVD+RW, or DVD-RW. 

2. In Windows Movie Maker, add the video, audio, and other digital media files you want to include in 
your movie to the storyboard/timeline. 
If you want, you can also edit the audio and video on the storyboard/timeline, as well as add other 
pieces to your movie such as titles, video effects, or video transitions. 

3. On the File menu, click Save Movie File, and then click DVD  –or- 
In the Movie Tasks pane, under Finish Movie, click Save to DVD. 

4. After the movie has been saved, do the following in the Create a DVD dialog box: 
• In the DVD Title dialog box, type a title for the DVD. 
• In the Video Title dialog box, type a title for the specific video. 
• For Drive, click the drive for your DVD recorder. 
• For Select a write speed, choose a write speed or accept the default. 
• In the Number of copies box, choose number of copies you want for specific DVD.
 

5. Click Create DVD to begin creating the DVD. 
Wait for the video files to be converted and copied to the DVD. This process can take an extended 
amount of time, and it depends on the length of your movie, processing speed of your computer, 
and on the write speed of your recordable DVD drive. 

6. In the Create a DVD dialog box, click OK when the DVD has been created. 
7. If the DVD is not ejected automatically from the recordable DVD drive, press the eject button on 

the recordable DVD drive. 
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Tips for Copying Your Windows Movie Maker Movies to a DVD 

Capture Video Using a Higher Quality Video Setting 

Choose a higher quality video setting when capturing video from a video camera or VCR. 
Choosing one of these higher video settings will provide better video quality for your final DVD. 

When capturing video from a DV camera in Windows Movie Maker, select a video setting that 
uses a resolution and format appropriate for your source device. 

On the Video Settings page of the Video Capture Wizard, click Other Settings, and then choose 
a high quality video setting that displays video at one of the following resolutions: 

• 720x480 pixels (for DV cameras that use the NTSC video format)
• 720x576 pixels (for DV cameras that use the PAL video format) 

For example, for DV cameras that use the NTSC video format, choose DV-AVI (NTSC) or High 
quality video (NTSC). For DV cameras that use the PAL video format, choose DV-AVI (PAL) or 
High quality video (PAL). 

When capturing video in Windows Movie Maker from an analog video camera or VCR that is 
connected to an analog capture device on your computer, use the highest video quality setting 
possible. For example, for capturing video from an analog video camera or VCR that is connected 
to an analog capture device on your computer, on the Video Settings page of the Video Capture 
Wizard, click Other settings, and then choose Video for local playback (2.1 Mbps). 

Choose the Appropriate Aspect Ratio in Windows Movie Maker 

In Windows Movie Maker, the movies you create will be saved at an aspect ratio of either 4:3 or 
16:9, depending on the aspect ratio settings in Windows Movie Maker. The aspect ratio for video 
specifies the ratio between the height and width of the video image. To view the current aspect 
ratio setting in Windows Movie Maker, on the Tools menu, click Options, and then click 
Advanced. 

When choosing an aspect ratio for the movie you plan to copy to a DVD, consider the type of 
monitor, screen, or TV on which you or your audience will watch the DVD. For example, if you are 
most likely watch the DVD on a widescreen TV that displays video at 16:9, choose 16:9 as the 
aspect ratio. However, if you think the movie will be watched primarily on a standard TV that 
displays 4:3 aspect ratio, choose the 4:3 aspect ratio. The aspect ratio you choose in Windows 
Movie Maker determines the aspect ratio of the final video on the DVD. 

To set the aspect ratio in Windows Movie Maker 

1. On the Tools menu, click Options, and then click the Advanced tab. 
2. Do one of the following, based on the aspect ratio you want to use for your saved movies: 

• Choose 4:3 if you want saved movies to be displayed at an aspect ratio of 4:3. 
• Choose 16:9 if you want saved movies to be displayed at an aspect ratio of 16:9. 
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Choose the Appropriate Video Format in Windows Movie Maker 

When you want to copy a Windows Movie Maker movie to a DVD, choose either NTSC or PAL video 
standard according to the country or region in which the DVD will be watched. Usually, you can just accept 
the default video format that is set in Windows Movie Maker. However, if you plan to send the DVD to 
friends and family in another country or region, make sure you choose the video format that is used in their 
country or region so that they can watch the DVD using their DVD player. 

To set the video format in Windows Movie Maker 

1. On the Tools menu, click Options, and then click the Advanced tab. 
2. Depending on DVD player that you or others will use to play back the movie on the DVD, do one of the 

following: 
• Select NTSC if the DVD player uses the NTSC video standard.
• Select PAL if the DVD player uses the PAL video standard. 
 

 

Create Shorter Movies in Windows Movie Maker 

When you create shorter movies in Windows Movie Maker, make sure the movie fits into the MPEG-2 video 
format that is used for the DVD when it is transcoded from Windows Media Format. 

In Windows Movie Maker, when you choose to save and copy a movie to DVD, a temporary video file is first 
saved in Windows Media Format. This Windows Media Video (WMV) file can be used by DVD creation 
software that comes installed on some computers running Microsoft Windows XP Media Center Edition 
2005. This DVD creation software transcodes the WMV file into MPEG-2 format, which is the video format 
used for DVDs. The software then copies the transcoded video to a DVD. 

If the size of your movie approaches the maximum capacity of the DVD media (usually 4.7 GB), a lower 
quality setting will be used when transcoding the movie so it will fit on the DVD. 

If your final movie is much larger than the capacity of a DVD, Windows Movie Maker will display a 
notification when you first try to save the movie. If this message appears, you should make the movie 
smaller so that it fits on the DVD. You can do this by removing parts of the movie to make it shorter, or by 
dividing the movie into two or more shorter movies that can be copied to separate DVDs. 

Save Your Windows Movie Maker Project on a Drive with Sufficient Free 
Disk Space 

If you have multiple hard disks installed on your computer or if you have a partitioned hard disk, save the 
Windows Movie Maker project file to a location that has enough available free space to store the project file 
and the temporary Windows Media file. You can help ensure that there is enough disk space available to 
save and copy a movie to DVD by saving the Windows Movie Maker project file, which has an .mswmm file 
name extension, to a location that has a lot of free disk space. 

In Windows Movie Maker in Windows XP Media Center Edition 2005, the temporary Windows Media movie 
file is saved in the same location as the saved Windows Movie Maker project file. However, if you do not 
want to save the Windows Movie Maker project, the temporary movie file is saved in the My Videos folder on 
your computer. 
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Note To copy a movie to a DVD starting from a Windows Movie Maker project 
file, make sure the project file is saved on your hard disk. A DVD cannot be 
created from a Windows Movie Maker project file that is stored on a shared 
network location. 

Insert a Recordable DVD 

Make sure you have a recordable DVD inserted in your recordable DVD drive before you start copying your 
movie to a DVD. Movies you create in Windows Movie Maker can be copied to a recordable DVD. However, 
movies you create in Windows Movie Maker cannot be saved as a Super VideoCD (SVCD), which is a CD 
that contains video in the MPEG-2 video format. 

 

Allow Time for Copying Movies to a DVD 

The time it takes to save your movie and copy it to a DVD depends on the length of the movie, as well as on 
the processing power of your computer and the writing speed of your recordable DVD drive. Therefore, 
make sure you allow enough time to save the movie to a DVD since the entire process could be time-
consuming. 

You can download the latest version of MovieMaker2 and other media at the following link: 

http://www.microsoft.com/windowsxp/downloads/powertoys/mmcreate.mspx 
 

 

 


